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	Introduction
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Note that while this tutorial assumes that you are using Windows 95, most of the information relating to photoshop will be directly applicable, irrespective of your operating system.
	Photoshop is a computer program that is used to manipulate bit-mapped computer graphics! It is an extremely powerful, but easy to use, application.
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There are two fundamental types of computer graphics: vector graphics and bitmap graphics. Vector graphics refers to graphic images where the graphic objects are stored as objects (for example: lines and circles). Examples of programs using vector graphics are CAD systems (eg: AutoCAD) and Illustration programs (eg: Corel Draw). Bitmap graphics refers to images where the colour value of each spot (pixel) of the image is stored. Programs producing bitmap graphics include Paint programs (eg: Paintbrush) and image-editing software (eg: Photoshop and Corel Paint). Photoshop and some other "high-end" image manipulation software use techniques pioneered by CAD systems (for example Layering) to blur the difference between vector and bitmap graphics.

	
	This Photoshop tutorial will introduce the basics of the application, including: 

· Starting Photoshop, Loading & Saving images 

· Selecting parts of an image 

· Colour manipulation 

· Zooming around 

· Photoshop's paint tools 

· Photoshop's editing tools 

· Layering (Photoshop style!) 

· Copy, Paste & Delete 

· Printing 

	Starting Photoshop
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	Start Photoshop by clicking on Start (at the bottom-left on the screen), then move the cursor to Programs, Graphics Applications, and then click Adobe Photoshop 4.0. The program will take a moment to load, so be patient.

	
	Initially, you might think the application looks a little odd! Like AutoCAD, there are a number of floating toolbars (called palettes in Photoshop); unlike in AutoCAD, the toolbar's title is not drawn at the top of the toolbar. The main toolbar is reproduced below:

	Where the tool icon has a small arrow in the bottom-right corner, there are additional tools (usually variations) accessible by holding the left mouse button down (over the icon).
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	Loading an image
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	Once you've created a Photoshop image (with a .PSD extension), you can load that image by double-clicking on the file's icon in Windows Explorer, this will reduce the amount of wading through directories that you do.

If you are not at UNSW 
you'll need to download the image by right-clicking on the thumbnail
(800x600) 205k
	Select File - Open (click on the "File" menu and then click on "Open"). Photoshop will (probably) initially display the contents of a directory on Drive C: (Photoshop's tutorial directory has some interesting images...). Change the Drive to P: (\\eureka\public or "Public on Eureka") and then find the \Samples\arch\photoshop directory. In that directory are a small number of images that I will use with this tutorial.

Select the image: room-8x6.gif this is a simple Raytraced image of a room, with a number of paintings on the walls and (what looks vaguely like) timber floor boards on the floor.

	That's my excuse and I'm sticking to it [image: image14.png]



	This image is a GIF bitmap image with "8 bit" colour, which means it has (a maximum of) 256 colours (28 = 256)! Unfortunately, the program I used to create the room model, which was used to create this image, has an incredibly primitive interface, so I made a few mistakes. So we'll try to fix some of the worst errors and have a bit of fun while we're doing it!

	This image was created by myself using a Raytracing program called Rayshade. If you are interested in seeing some other images created using this program have a look in the Rayshade Exhibits on the Faculty's Web Site.
	[image: image15.jpg]




	Note that when changing the colour Depth from 8 bit to 24 bit the image will not appear to change, because you are simply increasing the number of colours available.
	Firstly, we need to increase the number of colours available. Under the Image menu select Mode and then RGB color. This changes the image into a "24 bit image" which gives 224 (16 million) colours. This is necessary before the image can be manipulated (beyond simple cut & paste editing).

	Saving an image
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	Now that you've changed the image, let's save it: select Save from the File menu. Photoshop should select the directory from which the image was loaded and should choose Photoshop's PSD file format as the image format. 

Change the Drive the S: ("Students on Excelsior") select (double-click) your school and then search through the list to find your student directory (which should be a "u" followed by your student number). Finally, you may wish to change the name of the file from room-8x6.PSD to something else, though if you do this, make sure you leave the .PSD file extension.

	Selecting graphics
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	Photoshop provides 3 simple tools for selection: Marquee, Lasso and Colour wand (you'll find them at the top of the toolbar). In addition, you can use commands on the Select menu.

	Rectangle Marquee
	Select the rectangle marquee, then move the cursor over the image. Press the left mouse button and then drag the cursor down and right, when you release the mouse button the marquee is complete. 

	In the previous version of Photoshop, dragging a selection would have moved the graphics within the selection!
	Release the mouse button (if you haven't already done so), move the cursor inside the selection marquee (the shape of the cursor will change from a cross to an arrow head with a small marquee symbol), then drag the selection. This will move the selection marquee!

	Elliptical Marquee
	Select the elliptical marquee by alt-clicking on the rectangle marquee or holding the left mouse button down (over the marquee icon) and selecting the ellipse shape when the 'flyout' is displayed. The marquee is basically the same as the rectangle marquee, except, of course, that dragging the cursor produces an elliptical rather than a rectangular shape.

	Lasso
The alternative option 'under' the lasso icon is the polygon lasso – which allows you to draw a selection using straight lines.
	Select the Lasso. This tool is very similar to the marquee. BUT you are using a "freehand" tool to make the selection! Try it out. Notice that you don't need to "draw" a closed shape, Photoshop will complete (close) the selection for you!

	Colour Wand
The Options Palette is under the Navigator Palette...
The tolerance can range between 0 and 255. 0 means only exactly identical colours are selected, 255 selects everything.
	The colour wand (or "Magic Wand") is used to select areas with similar colours. Select the wand and then click on the wall, Photoshop should select a part of the wall, the tolerances can be changed (look on the Options Palette). Change the tolerance (from 32) to 75 and select again. Photoshop should select a much broader range of colour (probably too much).

	Combining Selections 

Note that the techniques below will work with all the selection tools...
	The question that quickly comes to most people using Photoshop is "How can I combine these techniques?" Well, the techniques can't exactly be combined, but selections can be joined...

	Adding to a Selection 

Subtracting from the selection 

Intersecting(!) the selection
	To construct a selection of multiple selections hold the shift key down when creating the selections. Holding the alt key down while creating additional selections causes the new selections to be subtracted from the already created selection. Holding the alt & shift keys down while making a selection causes the new selection to be intersected with the original selection!

	De-selecting
	To unselect everything, simply choose None from the Select menu, or click the right mouse button and choose Select None.

	Colour manipulation
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	There are a number of ways to select a colour in Photoshop.

	Be aware that some images may use groups of pixels, each with a slightly different colour, to produce an overall effect.
	Firstly, the Eyedropper on the main toolbar is extremely useful! Select the Eyedropper and click on the image, notice that the foreground colour has changed to the colour selected! This is usually the easiest and best way to set the current colour to match part of an image.

	Note that if you move the cursor outside the dialog box, it changes into the Eyedropper, and you can select colours from the image.
	To set the foreground (or background) colour, you can also click on the colour "sample" near the bottom of the main palette. Photoshop will display the Color Picker dialog box, which allows you to type in colour values or select the colour from the full range of possible colours.

	Make sure that the current layer has graphics within the selection area!
	Another form of colour manipulation is darkening or brightening the whole (or a selected part) of the image. Select the area to be altered (or choose Select - All). Choose Image - Adjust - Brightness/Contrast, then change either slider by clicking on the slider-line.

	
	There are a number of interesting options on the Image - Adjust sub-menu, the bottom one (Variations...) is particularly useful.

	Zoom
[image: image19.png]




	zoom-in 

zoom-out
	To zoom-in on a part of an image, select the zoom tool from the main palette, then move the cursor over the part that you wish to zoom-in on and click the left mouse button. To zoom-out, hold the alt key down and click the left mouse button.

	zoom-window 

zoom-all
	Select the zoom tool and then "draw" a selection rectangle around the misplaced railing shown on the image above. If you make a mistake and zoom in on the wrong spot, simply double-click on the zoom tool on the toolbar and try again!

	Double-clicking on the hand icon [image: image20.png]


results in the image being redisplayed with zooming appropriate to fit image on the screen.
	A few more quick tips on the zoom tool: 

· double-click on the zoom icon to get the image displayed at 1:1 scale. 

· ctrl+"-" & ctrl+"+" enlarge and reduce the display scale - ctrl+"+" makes the pixels bigger. 

· ctrl+spacebar+click - magnifies the image (at the selected point) 

· alt+spacebar+click - "un-magnifies" the image [image: image21.png]




	Paint Tools
[image: image22.png]




	Note that if a selection is "in force" then the paint tools are clipped to the selection area.
	While Photoshop is quite limited in the range and power of the drawing tools available (no circles!) they can be used to draw a wide variety of shapes.

	If you load a GIF image, remember to change the Mode to RGB colour (using Image - Mode...)
	Read through the descriptions of the paint tools below and experiment with the tools, either on the current image, or load another image, either from Photoshop's tutorial directory or from the sample images on Eureka Public (in p:\Samples\arch\photoshop).

	Text [image: image23.png]



	Adding text to an image with Photoshop is very simple. Click on the text icon and then click where the text is to be placed. Photoshop will display the "Type Tool" dialog box, this allows the text to be entered and the characteristics of the text (font, size, alignment etc) to be set. Select "Ok" when you're happy with the text, the text will then be added (on a new layer).

	Paint Bucket [image: image24.png]



	The Paint bucket tool is fairly straightforward. Simply click on the tool and then move the cursor into the drawing area and click... the foreground colour will be used to fill the canvas, until the edge of the current selection or until a pixel of a different colour is encountered.

	Gradient Fill [image: image25.png]



There are lots of interesting options to investigate here! The "Style" setting on the Options Palette can be used to dramatically alter the way the gradient fill is executed...
	The gradient fill fills an area, like the paint-bucket, but instead of using just one colour will use a range of colours - gradually changing from one colour to another. After selecting the tool, simply select two points (hold the mouse button down) and Photoshop then draws the gradient fill. The fill can be constrained by the current selection.

	Line [image: image26.png]



To constrain the line to a multiple of 45 deg., hold the shift key down while drawing. The technique works with most of the tools...
	The line tool is used to draw straight lines! The thickness of the line can be set using the Options Palette. Unfortunately, Photoshop's implementation is quite limited, for example, the thickness of the line can not be made to vary along the length of the line.

	Pencil [image: image27.png]



	The pencil, is very like the line, but it is used to draw "freehand" (rather than straight) lines.

	Airbrush [image: image28.png]



	The airbrush tool works like a spray-can, the longer the tool paints an area the more saturated the area becomes and the tool's edges are "soft". The diameter of the spray can be set using the "Brushes" section of the options palette.

	Paintbrush [image: image29.png]



If you're interested in creating "custom" brushes use Help (and search for brushes).
	The paintbrush is very like the airbrush. The main difference is that continually painting the same spot doesn't alter the image. The fade option is worth looking at... try setting it to a low number (for example: 10).

	Editing Tools:
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	Investigate these tools using an image!
	These editing tools (like the paint tools) will either work on the whole of the current layer or on the currently selected area...

	Eraser [image: image31.png]



Try this tool with a non-white background colour!
	The eraser normally replaces the graphics erased with the background colour. There are two interesting options (on the bottom of the options palette). 

"Wet Edges" is really fun - it "half" erases - it's as if with a semi-transparent brush were being used to be the painting! "Erase to Saved" is very useful, because of Photoshop's limited undo facility. If this option is set, the eraser will restore the area being erased back to the way it was when the image was last saved.

	Rubber Stamp [image: image32.png]



This tool also works when the "source" and "destination" areas are on different images...
	The rubber stamp is a tool that allows a part of an image to be duplicated. After selecting the tool, move the cursor to the area you want to copy, then hold the alt key down and click with the left button - this establishes the initial reference point. Move the cursor to where the "copy" is to be placed and start drawing! There are a whole swag of interesting options with this tool. Look in the "Option" drop-down list. For example: select "Impressionist" - and have fun!

	Smudge [image: image33.png]



	The smudge tool - as you'd expect - smudges the graphics where it's used. Select the tool and then draw a "sweeping" stroke across the image.

	Blur [image: image34.png]


and Sharpen [image: image35.png]



	This is two tools in one. The default tool is blur, but if you hold the button down the 'fly-out' is displayed (which shows sharpen).

	Dodge [image: image36.png]


, Burn [image: image37.png]


, Sponge [image: image38.png]



	These three tools mimic photographic techniques to lighten or darken images. Dodge is used to lighten an image, Burn darkens an image, while the Sponge tool increases the (colour) saturation. The selected tool can be changed by alt-clicking on the tool's button or by selecting the tool in the drop-down list of the Palette.

	
If you aren't at UNSW, click on the 'thumbnail' and once it's downloaded right-click on the image and save it.
	
Now, reload the raytraced room image (if necessary), then zoom in on the incorrectly shown balustrade and fix it(!) by painting over the railing (use the Eyedropper and the Pencil).

	Layers
[image: image39.png]




	
	Conceptually, layering is very simple: imagine drawing an image on a number of transparent sheets, laying the sheets on top of each other and then copying those sheets to produce a final image.

	"Channels" are used to store colour information and to store selections. Paths are another way of storing selections.
	Photoshop implements this concept in a very simple and straight-forward manner! Look at the various "floating toolbars" (palettes) - notice one that has three tabs at the top labelled "Layers", "Channels" and "Paths" - this is the Layers palette. The Layer tab is normally the one selected.

	GIF images are made up of pixels chosen from a small selection of colours, so changing one instance would change all instances of that colour...
	Only "full colour" images can use layers. GIF images can't have layers in Photoshop (except the "Background" layer), the "mode" must firstly be changed (using the Image - Mode) from "Indexed Color" to "RGB color" or "CMYK color" – if that has not already been done.

	In addition, a layer can be made invisible by clicking on the "eye" in the first column. A Layer's opacity can also be changed!
	The Layer palette shows information about all the layers in the current image and allows the user to change various things about the layers. The "order" of the layers can be changed (in Photoshop - unlike a CAD system - "higher" layers can cover the layers beneath), by dragging a layer it can be moved to a new position in the "stack".

	
This is 460k a PSD file, so if you want to download it, remember to right-click on the thumbnail and select "Save Link As.." (Netscape) or "Save Target As..." (Internet Explorer)!!!

This image (which came with Photoshop version 3) provides a wonderful example of the possibilities of layers in Photoshop.
	
Load postcard.psd from:
        p:\Samples\arch\photoshop\

Once the image is loaded, use File - Save As to save the image in your own directory area.

	If the Layers Palette is not visible, select Window - Show Layers.
	Click near the top-right corner of the Layers Palette (see figure) - this does not close the palette - it will, in-fact, enlarge the palette to show all the layers in the image!

	Changing a layer's transparency... 
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	Normally only one layer - the "current layer" - is changed at a time, this layer is highlighted in the palette with a blue background. Click on the sun layer, this makes that layer the current layer (selection operations will relate only to the graphics on that layer). Note the "Opacity" setting (40%) near the top of the palette - this means that the graphics on this layer are "faded" and that graphics under this layer will show through the graphics on this layer. 

Hold the alt key and click on the sun layer "eye" (in the first column) - this will turn all the other layers off, making them temporarily invisible. This shows what is on this particular layer. Alt-click the eye again to turn the other layers back on. 

With all the layers on, look carefully at the sun. Note how the leaf and the wheat can be seen through the sun. Click the eye of the leaf layer to turn that layer off. Increase the Opacity of the sun layer and see how that effects the image. Turn the leaf layer back on when finished. 

Notice that below the Layers tab label at the top of the palette there is a drop-down list with "Normal" showing. This setting controls how the graphics on this layer effect the graphics on the other layers...

	Try changing the settings of some of the other layers...
	Click on the leaf layer to make it the current layer. Note that the setting for this layer is "Difference". Change the setting to "Normal" and study the effect this has on the image. Try out some of the other settings...

	The only layer that can't be re-positioned is the "Background" layer - it is always on the bottom, always "Normal" and can't have its opacity altered.
	To change a layer's position in the "stack", drag the layer from its current position to a new position! Try it...

	New Layer Mask button [image: image41.png]



New Layer button [image: image42.png]



Delete Layer button [image: image43.png]



	Finally, on the bottom of the layers palette are three icons. The New Layer Mask icon, adds a new layer (associated with the current layer) that can 'mask' part of the associated layer: any areas of the mask layer that are painted black, render invisible the equivalent area on the associated layer. The actions of the other two icons are fairly straightforward, one deletes the current layer and the other creates a new layer above the current layer.

	Duplicating Layers
	A layer can be copied by selecting the layer (by clicking on the layer in the layers palette), choosing Select - All, and then selecting Edit - Copy. This layer can then be pasted into a different image (by selecting the other image and pasting) or can be pasted back into the same image, duplicating the layer.

	Copy, Paste & Delete
[image: image44.png]




	
	Photoshop supports the standard editing commands: copy (Ctrl+c), cut (Ctrl+x), paste (Ctrl+v) and delete (Delete key), as you would expect.

	Copy and Paste
	Select part of the image (if you haven't already) and then select copy - nothing much will happen, of course! Now select paste, a copy of the selection is placed on a new layer and that new layer becomes the current layer. While holding the ctrl key down drag the mouse cursor - this moves the contents of the current layer!

	Cut and Paste
	Click on a layer in the Layers Palette - this will change the current layer. Select part of the image and select cut. The selected graphics will disappear (you've erased it). Select paste, the graphics will appear, on a new layer (above the current layer).

	Matters of Scale
[image: image45.png]




	How long is a piece of string?
	One important concept to understand when using an application that provides a semi abstract view of some information is that (normally) the information can be printed at any size. For example when drawing a room using a CAD system you should use the room's real dimensions not the dimensions of the graphics as they would appear on paper - because once you've drawn the object you can then print it at different scales.

	dpi = dots per inch
(an inch is 2.54 cm)
	When scanning graphics, you might scan the graphics at 100 dpi and get an image 200 x 300 pixels. If you bring that image into Photoshop, work on it and then print it the resultant image might be the size of a postage stamp or could cover an A4 page... 

Equally, you could scan the same graphics at 400 dpi (and get an image 800 x 1200 pixels) then print it via Photoshop and again the image could be the size of a postage stamp or cover the whole page.

	If you are going to print a image, then you're usually best advised to scan the graphics at a reasonably high resolution.
	The image scanned at higher resolution (dpi) will normally produce a much better result when it's printed, because there is more "information" - the image has more pixels.

	When using JPG images you can usually set the quality (Q) value, this (usually) ranges from 0 to 100, with normal values between 75 and 90.
	The difficulty you may encounter is trying to copy this scanned graphic onto a floppy disk - if you must use a floppy disk, then convert the image to a JPG image - even though you'll lose some quality - you'll probably fit it on a disk.

	 
	

	The Dialog actually seen may be different, depending on the units currently in use the Current Size section. 

For example, if you're using A4 (portrait) with a 1cm margin (top & bottom) it would be: 29.7 - 2 = 27.7 

Note that this does not alter the image. In effect you are changing the "print scale".
	Load an image into Photoshop and then select Image - Image Size. The dialog shown below will be displayed. Click in the box beside Resample Image (to remove the tick) at the bottom of the dialog (notice the "constrain" symbol now extends over Resolution). Change the Height to the height of your page minus the margins - the resolution (and width) will automatically change to maintain the proportions of the image.

	[image: image51.jpg]


Notice that "Resample Image" (at the bottom of the dialog box) has been de-selected. When this is selected, changing the width, height or resolution will cause Photoshop to resize your image. When it is not set, changing the settings changes the "print scale", resulting in the printed image being smaller of larger - but not effecting the image file. 
Figure 1 - Image Size Dialog[image: image46.png]




	
	Notice that the above assumes the image is predominantly vertical (portrait). In the example below I'll use a horizontal (landscape) image.

	Printing Example
[image: image47.png]




	
(800x540) 69.4k
	Load the image syd18.jpg from \Samples\arch\photoshop on drive P: (\\eureka\public or "Public on Eureka"), and then save the image in your own directory area.

	The alternate way to find out the current size of the image is to move the mouse to the "Doc:" status area at the bottom of the application, hold the alt key and the left mouse button down!
	Select Image - Image Size, you should see that the image is 28.22 x 19.05 cm at 72 dpi, and that the image is 800 x 540 pixels. Select Cancel to dismiss the dialog.

	Page Setup
	Select File - Page Setup. Change the Orientation of the page from Portrait to Landscape. Check that the selected printer is correct (it should be the postscript printer if you're in AG02). There are a number of other options on this dialog but they can be ignored at present.

	Image Size
("Print Scale")
	Select Image - Image Size, make sure that Resample Image (at the bottom of the dialog) is not ticked.

	This assumes that you want the image as large as possible on the sheet of paper. You might, in fact, want the image to be smaller, or you might want the image larger than the page - set the values accordingly.
	Type in the width of the (landscape) page, for example 27.7cm, and make sure that the height is OK - that is, the height should be less than the height of the page minus the margins (for example 19.0cm). If the height is too much then set the height value equal to the maximum value (the width will automatically be adjusted). Select OK to dismiss this dialog box.

	Printing 

The printing technique explained here is, of course, only appropriate for students in the Faculty's Computer Labs - and even there, it's best to check the instructions posted in the Lab. 
It costs $2.00 ? per page to print on the Tektronics colour printer. 

Generally, if there's a problem with the printer see the BECU folks - their office is off AG03.
	When you're ready to print, select File - Print. At the bottom of the dialog you can set the print to be grayscale or colour - set it as appropriate(!) and then select OK. In the computer labs a Print to File dialog will be displayed change the drive to Q: and then type in a print file name (for example: syd18.ps). 

Please note that I do not require that you print out this (or any other) image! I'd recommend that you select Cancel, instead of OK, to dismiss the dialog - unless you really want to print it! 

Finally, go to the printer and follow the instructions there! Be patient with the printer because it can take a while!


	Keyboard Shortcuts
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	[image: image49.png]



	M
	Marquee

	
	V
	Move

	
	L
	Lasso

	
	W
	Colour Wand

	
	A
	Airbrush

	
	B
	Paintbrush

	
	E
	Eraser

	
	Y
	Pencil

	
	S
	Rubber stamp

	
	U
	Smudge

	
	R
	Blur (or Sharpen)

	
	O
	Dodge (or Burn or Sponge)

	
	P
	Pen

	
	T
	Text

	
	N
	Line

	
	G
	Gradient Fill

	
	K
	Paint Bucket

	
	I
	Eyedropper

	
	H
	Hand

	
	Z
	Zoom

	
	X
	Switch foreground and background colours

	
	D
	Reset colours to defaults

	
	Q
	Standard (or Quick Mask) mode [toggle]

	
	F
	Screen modes toggle

	 
	
	

	
	Tab
	Show or hide all palettes

	
	Shift + Tab
	Show or hide all palettes, except main toolbar

	 
	
	

	
	Ctrl + Space + click
	Zoom in at specified position

	
	Alt + Space + click
	Zoom out at specified position

	
	Ctrl -
	Zoom out (reduce display size of image)

	
	Ctrl +
	Zoom in (increase display size of image)

	 
	
	

	
	Shift + select
	Add to selection

	
	Alt + select
	Subtracts from selection

	
	Shift + Alt + select
	Intersect current selection with existing selection

	 
	
	

	
	Ctrl + X
	Cut current selection to the clipboard

	
	Ctrl + C
	Copy current selection to the clipboard

	
	Ctrl + V
	Paste clipboard contents onto a new layer

	
	Alt drag with [image: image50.png]



	Moves a copy of the current selection

	
	Eyedropper + Alt + click
	Sets the background colour

	
	Alt + Backspace
	Fills current selection with foreground colour

	
	Shift + Backspace
	Display Fill dialog box

	
	Ctrl + Delete
	Fills current selection with background colour

	 
	
	

	
	Ctrl + F
	Repeat last filter

	
	Alt + Ctrl + F
	Opens last filter dialog box

	
	Esc
	Cancel operation
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